
 

Photoshop Hints and Tips 

Preferences in Photoshop 

Checking how you want to set up your working space. Go to Menu Bar 
and Edit, Preferences, General. Keep pressing next to find the boxes 
you need to alter. I set the Displays and Cursors to Brush Size and 
Precise, Units and Rulers to option you require, I like inches, Plug Ins 
and Scratch Disks, if you have a secondary hard disk space then set 
the second line to your second disk space, Memory and Image Cache, 
the maximum used by Photoshop is usually preset to 50% but this 
should be increased to say 85% to give you maximum memory usage 
whilst using Photoshop. The extra 15% I save for using the printer. 

 
Raw  

• Raw has a lot of exposure latitude – highlight detail can be 
rescued much easier in Raw. A Raw image is like a negative, it 
will always be there and the image you open from it and save 
does not alter the original Raw image.  

• Loads of adjustments can be made in raw before going to 
Photoshop. Changing the Temperature sometimes helps the 
image. . 

• You can also change from 8 bit to 16 bit if you want more 
information but it will make the file considerably larger. 

• You can also open the image as a lower resolution image if 
required. 

• You can open a Raw image several times. For example make the 
adjustments for just the sky only and open. Next time make the 
adjustments for the base only and open.  

• You then put the two images together, go to move tool and click 
on an image and drag to the other image whilst holding down the 
shift key (this will centre the image automatically). 



• Make a Layer Mask and rub out as required. Previous notes 
describe how to use Layer masks.  

• Crop if necessary which can be changed to any aspect Ratio 

• Camera Lens where Enable Lens Correction which can be 
altered and also saved 

• Noise (Zoom 100%) (Luminance 45 shadow areas and Colour 25) 
Not too much as it will go too mushy.  

• Spot removal tool. Click on it. Heal or Clone. Radius and 
Opacity. Size can be changed with mouse on the screen. There 
will appear a red circle which is the area just clicked and want to 
target and a green circle which is the area we sample from. Use 
the opacity as required. 

• Soften area, switch to clone, opacity down to 15. Do a series of 
clicks in the same way. 

• Adjustment Brush. Zero out all the adjustment values. Zero out 
the Colour as well by clicking on the colour and move slider 
down to zero. Show Mask and choose a colour. Make a pin which 
will show the colour and paint the area where necessary. 
Change brush as necessary. After mask has been created 
Uncheck the Mask colour. Changes can now be made to the 
mask area only and to soften an area move the Clarity Slider 
down. 

• Target other areas by created new pins. Hit New and zero out all 
the values. Click on Show Mask. Whilst making mask; hitting alt 
you can take away some of the mask. Small adjustments can 
then be made to different mask areas. 

• For instance to change or colour an eye, do the mask as above 
but on Colour change this to say Blue which is a great way to 
change the eye colour. 



• Graduated Filter. Drag over to make a graduated filter. Use to 
give a bit of an edge. Again zero out the values. You can double 
click on the Colour and add a tint as necessary.  

  

Image Size for Printing  

 
You will need to check your image size for printing. On the Menu Bar go 
to Image, Image Size For quality you must not tick the resample box, 
this must be unchecked. If you resample, (which is fine for emailing), 
then you interpolate the pixels and quality is lost. Obviously if you are 
doing a “manipulated/derivative” image then this will not matter. There 
is a bracket joining the size and resolution together, so whatever box 
you alter then the others will alter accordingly. Some cameras 
download 72dpi, some 180dpi and some at 240dpi. So you should see 
either 240, 180 or 72 in the resolution space.  
Sizing for Emails & Saving for Web  
You can use this method for saving Digital Images for competitions, 
the web and email. Very often you are asked for maximum width and 
maximum height in pixels so below is based on 1600 x 1200 pixels. 

 

• First of all I suggest you make a duplicate of your original so that 
you do not mess up all your hard work by going to Image, 
Duplicate. Use this one to work on for your email image 

• Now go to Image, Image Size and go to the Pixel Dimensions area 
at the top. Do not worry about the Document Size box, this is 
only for printing. 

• Tick the Resample Image box which is at the bottom of the 
menu. (This is only for resizing down, i.e. for projecting) 

• For a horizontal image change the width to 1600 pixels and make 
sure that the Height is no more than 1200 pixels For a vertical 
image change the Height to 1200 pixels. 



• Go to File, Export, Save for Web (Legacy) . A Save for Web Screen 
will show. You can Click on 2-up. The left hand image is your 
original and the other one is optimized image. 

• The Settings Box has a drop down menu, click on JPEG Very High 
to start with. Make sure the Optimized box is ticked. The 
Progressive and ICC Profile are left unticked.  

• Convert to sRGB, is usually ticked by default. This is important 
as when projected in a competition or on the web the colours 
will be more accurate.  

• You will now see the File Size and Time under each image plus 
the quality.  

• You can change the Quality and make it higher or lower. You can 
alter this by clicking on Maximum, Very High, High etc.  

• Click OK on the top right to save. It will automatically save as a 
JPEG. Save this JPEG where required on your computer under a 
name required. Perhaps a good idea to have a folder saying 
Email Images or Competition Images. 

• You will find that the image left on the Photoshop screen is not 
the one you have just saved. It should still be the duplicate, i.e. it 
should have the title with the word copy after it and psd but of 
course you have made it smaller.  

• You can close down this image without saving as this was the 
duplicate image. Your original image will still be there so you can 
carry on working on it or just save. However if you did not make a 
duplicate then do not save the image on the screen as it has 
been made smaller. 

• You now have two copies of the image on your computer. One 
the larger size and one JPEG (a much smaller one, not suitable 
for printing but ideal for emailing).  

 

 



Sharpening use High Pass 

• Duplicate Layer 

• Filter, Other, High Pass. Adjust slider to your requirements, trial 
and error. Click OK 

• Change Blending Mode in the Layer Palette – try soft light to start 
with.  

• If you feel the sharpening is too much then reduce this layer's 
opacity. 

• Alternatively you can selectively sharpen certain areas only by 
removing the areas not requiring sharpening by using a layer 
mask. 

  

  

Sharpening for Digital Projection and Email  

 
Decide on the end result size required; 1400 x 1050 as an example. 
Make you image exactly double this size by changing your image to 
2800 x 2100. Go to Filter and Sharpen (not unsharp). Click on Sharpen, 
then go to the Filter again and click on Sharpen again, then go to the 
Filter and click on Sharpen again, i.e. 3 times. The image will look 
awful. Sometimes an image only has to be sharpened twice.  
You then reduce your image to the required size, i.e. 1400 x 1050, 
instantly the image looks OK. Save as required, I usually use the Save 
for Web settings making sure its profile is set to sRGB. However if you 
are using the image for say the WCPF with the different sizes and in 
TIFF format then you will have to save normally. 

 

 

 

 



Levels  

 
To alter the image if too dark or light. Open your Layers Palette which 
can be found by clicking on Window at the top of Photoshop and click 
on Layer. On the Layer Palette at the bottom there is a small circle that 
is black and white, which will say Create New File or Adjustment Layer 
if you hold your mouse over the symbol. Click on this and go to Levels. 
A Levels box will open which can be dragged anywhere in your 
workspace by clicking on to the top and holding down the mouse then 
dragging. The three sliders half way down will alter your histogram – 
the left hand slider is the shadows, middle slider is midtones and right 
hand slider is highlights. Usually you will find your highlights are OK 
and only the midtones need to be altered. Sliding the middle one to the 
left will lighten the midtones. Clicking on the Channel drop down box 
will show Red, Green and Blue. This can also be altered as required. 
Click OK. You will now have a Level layer in your Layers Palette which 
can be accessed again by double clicking in the black & white circle. 
You can make as many Adjustment Levels as required. Clicking on the 
eye will switch on/off.  

 
Quick Mask 

 

• This is another good method of selecting areas but you do need 
to change the default setting in Photoshop of the Quick Mask. In 
the Tool Bar at the very bottom there is a small square with a 
circle in the middle. Double click on this and a menu will appear, 
you need to click on Selected Areas. I myself choose the opacity 
to be 100% because I like to see clearly where I have brushed. 
Click OK. 

• Making sure you are on the correct layer, usually the Background 
Layer, click on the Quick Mask (Q). You are now in Quick Mask 
and will find that the Background has turn Grey from the Normal 
Blue. 



• Go to your Brush Tool and make sure the brush is soft.  

• Brush over the area you wish to select – the area will go red. 

• Now click Quick Mask (Q) again at the bottom of the Tool Bar. 

• Marching ants will appear, these are the selected areas.  

• This method is useful for selecting parts of a picture roughly 
without selecting very accurately.  

• You can then make the necessary adjustments using Levels or 
Curves. 

  

  

Actions 

·     Open the Action Pallette by clicking on the Window Drop down Box 
in Photoshop and clicking on Actions. 

·     In the top right there is a small drop down arrow beside some lines, 
its very small, click here and click on New Set. 

·     With your Image Open and on the layer you wish to work on 

·     Again Click on small arrow (top right) to in the Actions Palette and 
choose NEW ACTION 

·     Type in a NAME you wish to call the action and click on RECORD 

·     Go through the whole action you wish to record i.e. sizing for PTE 

·     Go to File > Automate>Fit Image 

·      (Based on 3x2 or 16x9) Make the pixels 2200 wide x 1500 high 

·     Tick the box Don’t enlarge 

·     File>Export>Save for Web (Legacy) 

·     Make sure its JPEG – can use very high- the convert to sRGB is 
automatically ticked 



·     Click Save which will open your Filing System – Save to the folder 
you are going to have your AV images in. 

·     Then Close your image BUT DO NOT SAVE.   Reason, you are 
working on original image and during  process made it smaller. 
  

  

  

To run the Action, click on the Named Action you have created and just 
press the Play button which is little arrow at the bottom of the Action 
Menu. 
As mentioned above a Pause can be inserted, this is done after you 
have pressed the Stop button and completed your actions. Find you 
named Action. There will be some greyed out squares, click on the 
square/squares you wish the actions to pause.  
When you play your action and if it has a stop in it when it gets to the 
Stop you just click on Stop and do your adjustments. You will find that 
in the Action Box the next action is highlighted, you then just press the 
play button again to make the action continue. 
If you have several pictures to do at once then go to File, Automate and 
click on Batch and a Menu Box will open. There are several ways to do 
this.  

 

• In the Action box click on the drop down box and choose the one 
you want. 

• In the Source you can choose the File Folder by clicking on 
Browse. 

• Again in the destination click browse and choose the folder. 

• Click OK 

  

  



All the files you have chosen will get all the moves you wish to make in 
your action and if you have chosen to pause an action you can then 
lets say alter the crop, alter the levels and just click OK after each 
alteration.  

 

Dodge and Burn in Overlay Mode 

  

• Dodge and Burn In Overlay Layer without destroying the original 
image.  

• Open the image. Make a new layer by clicking on Create a New 
Layer in the Layer Palette.  

• Go to Edit, Fill with 50% Gray. Make sure the Opacity is still at 
100% and the Preserve Transparency is not ticked.  

• At top of Layer Palette change the blending mode to Overlay.  

• Dodge or burn as necessary.  

  

  

Any dodging will not alter the original image. You can delete the layer if 
required or click off. This Overlay Layer is virtually a transparent layer 
but one that can be worked on.  

 
Changing Shape of a Brush 

 
Sometimes it is necessary to change a brush shape, i.e. bits of grass 
etc. Go to your Brush Palette, this can be found by going to Window at 
the top of Photoshop and clicking on Brush. A Palette will open and by 
clicking on Brush Tip Shape you will see a diagram to the right, this can 
be altered as required.  



 
Canvas Size 

  

Sometimes it may be necessary to make your Canvas larger but not 
the image, i.e. putting a border around the image.  

• In the layer palette make a duplicate layer of the image 

• With the background highlighted go to Image, Canvas Size. 

• If a border is required then leave the white area in the middle. 

• By clicking on Relative you can just add say 1 inch on both the 
hight and width, by unchecking the Relative you can change the 
size to an exact amount required, i.e. 16” x 12”. Change to size 
and colour required. Click OK 

• Go to layer palette and click on the duplicate layer. By pressing 
Ctrl whilst you click on the layer thumbnail the marching ants 
will appear around the image exactly, you can then make your 
necessary borders by going to Select, Modify and Expand as 
required.  

  

  

Layers  

  

A layer can be an Adjustment Layer (Levels, Hue & Saturation etc) or 
another object, or a duplicate of your background layer. These are just 
piled on top of each other on which masks can be added in order to 
“erase away” only some part of that layer which will enable to see 
some of the layer below. An adjustment layer is what it says, it is for 
altering the exposure, contrast, hue, colours etc. 

  

 



Clipping Masks  

  

Sometimes you may need to do an adjustment to a layer without 
affecting other layers. You will need to make it a Clipping Mask. Do this 
by clicking on the third symbol in, looks like a microphone or an arrow 
depending on your software. This will just apply the Levels/Curves to 
the layer below. 

 
Layer Masks  

 
As an exercise find a figure or item that you wish to cut out from an 
image and place in another image. (Make a rough selection using a 
selection tool on the item you wish to use; copy it and paste it, into the 
image you will be working on) 

• Open the Layer Palette and make sure the item you have pasted 
into the image is active, i.e. it should be highlighted blue. 

• To make a layer mask go to the Layer Palette and click on the 
square with the white circle in the middle.  

• Make sure that the Layer Mask is active, i.e. there will be a small 
square with the white circle on display next to the eye icon in the 
layer you are working on. If there is a picture of a brush then you 
are not in the layer mask. Just click on the white square then the 
layer mask is active. 

• Make sure the background colours are black/white. The black 
does the erasing and the white puts it back 

• Choose a brush in the Tool Box – providing the Cap Lock is not 
on, use the square brackets to increase or decrease the size of 
the brush. Use whatever opacity you like, suggest you start with 
100% to see what happens. (The opacity can be changed in the 
Options Bar or just press a number to change the percentage, 4 
= 40%). With the black on top in the background colours gently 



erase the parts you don’t want. If you go wrong change the 
background colour to white and go over it again, magic, what you 
have rubbed out returns.  

• With practise you can rub small parts out at a time and with the 
opacity of the brush reduced to different percentages you can 
blend in the layer into the underlying layer. Again, practise with 
any image to see how it works.  

  

  

Cropping 

  

• An image can be cropped to a specified size by entering the 
amounts in the boxes on the Options Bar 

• A resolution may be put in but be careful you have enough pixels 
in the original to stop interpolation. To check amount to enter in 
the resolution box in the Options Bar of the Crop Tool do the 
following exercise. 

• Go to Image, Image size to check the original size. Say for 
instance you wish to make a 10 x 8 image without changing the 
resolution too much. To test the resolution type the smallest 
measurement required, in this case the height as 8” (obviously 
the proportions will not make the width 10”, will probably be 
nearer 12”). This will give you an idea what the resolution should 
be.  

• Now go to Crop Tool. Enter 10 in in width, 8 in in height and say 
256 in the resolution pixels/inch. Crop as required. The crop tool 
will keep to the proportions you have entered. 

 
Borders 

• Drag the Background Layer down to New Layer (Ctrl J) (You will 
now have two layers of the same picture. 



• Go to Image, Canvas size on the Menu Bar 

• A box will open, leave the white area in the middle, click on 
Relative and in the width and height put say .5 inches. The 
background colour will now be the colour that is depicted in your 
Foreground colour in the Tool Box 

• On the Background Copy put the mouse on the picture area and 
Ctrl Click. Marching ants will now surround the image. 

• Now Click on the bottom layer (Background). This means you will 
be able to get rid of the layer if all goes wrong. The copy 
background will still be there without the border in place. 

• Go to Select, Modify and Expand. Expand however many pixels 
you require the border to be outside the image 

• The colour of the border will be whatever is showing on the 
Foreground Colour in the Tool Box. To change this to a 
complimentary colour in the image place mouse on the 
Foreground Colour in the Tool box and then click the mouse on 
the colour required in the image. Click OK. 

• Go to Edit. Stroke and select pixel size. 1 or 2 is sufficient..  

  

 

Merge Visible and leaving intact the layers below 

• Click on to the top layer 

• Go to the bottom of the Layer Palette and click on New Layer 

• Go to Layer and down to Merge Visible 

• Click on Merge Visible but whilst holding your click on the mouse 
press down on the Alt key. 

• Still holding Alt key let go of your mouse click on the Merge 
Visible 



• The whole of the image including the layers will appear in the 
New Layer. .  

  

  

Red Eye 

 
Go to the Layer Palette and click on the bottom and make new layer. 
It’s the little icon that looks like a book and says create a new layer if 
you hold the mouse over the icon. Change the Blending mode to 
Colour. You will see that at the top of the layer palette it says Normal. 
Click here to change it to Colour. Now go to the Brush in the Tool Box 
(not the history brush) and make it soft and change the size to fit the 
eye. You can change the size of the brush by tapping the square 
bracket keys [up and down] to increase or decrease. Brush out the red 
eye. The Layer can now be merged down to the Background Layer. 
(This procedure nowadays is not so necessary as there are other Red 
Eye icon/symbols within the software)  

 
Adding a Sky using Blend If 

 
Select the two pictures to be blended. Like a landscape and sky. Drag 
and drop the "sky" into the main picture. Leave the sky picture on top 
of the landscape and move it into the correct position. Go to Layer 
Palette and click the small arrow top right. In the drop down menu 
select Blending Options. In the Blend If box, bottom of the panel, click 
and slide the pointer in the UNDERLYING LAYER. By moving the pointer 
you will blend the underlying layer into the top layer. By ALT/CLICKING 
the pointer you can split the operation to extend the Blending Range. 
When happy with the results click OK.  

 
 

 



Horizon, making it level.  

 
Go to the Tool Box and select the Eyedropper tool which will go out 
showing other tools. Select the measuring tool. Click on to the image 
and draw across the horizon that is sloping. Go to the Menu Bar, 
Image, Rotate Canvas, Arbitrary and click OK.  

 
Cloning 

 
This is ideal to get rid of spots, the odd small detail not required. The 
Clone tool is in the Tool Box fifth down on the left (Elements, just 
above the Hand). I find it difficult to explain the clone tool in notes, it’s 
really a lot of practise. However, by clicking on the Clone Tool (make 
sure it’s not the Pattern Clone Stamp) and choosing the appropriate 
brush, (try a hard one then a soft one and see the difference), Hold 
down the Alt. key and click with the mouse on the area you wish to pick 
up the colour/image. i.e. spotting out marks in a sky, click near the 
spot to find the pixel colour nearest to the spot. Now click with your 
brush on the spot at say 50% opacity. Its difficult to say which opacity, 
soft/hard brush you should use, its practise. If you make sure the Align 
box in the Options Bar is ticked, then every time you click with the 
mouse the area that you first identified with the Alt key will move in 
conjunction with the brush. If you uncheck the Align Box then it will 
always use the part you first identified with the Alt. key.  

 
Doing a Test Strip  

• Open and make a new A4 sheet of paper to the dpi using to print 
the main image 

• Use marquee square tool to make a long thin test area 

• Make sure the background colours are black and white 

• Go to Gradient Tool – in Linear mode 



• Make sure it’s the 3rd one along – Black to White 

• Drag the Gradient Tool top to bottom 

• Go to Adjustment Layers and Posterize and set at 25 

• Go to Info palette and gradually work way down to give 10% 
gradations 

• Print to see if blacks are blocked out, should be able to see the 
25 gradations when printed 

 

Smart Objects  

 
Very useful for the control of filters. With your background image 
highlighted make a copy of this by dragging down to the New Layer 
within the Layers Palette or shortcut Ctrl J. With the copy background 
highlighted go to Layer, down to Smart Objects and click on Convert to 
Smart Object. 

You can now work on this Smart Object Layer. Go to a Filter, i.e. Motion 
Blur and say OK. If then at anytime you wish to change the settings of 
this particular filter you can double click on the filter name you used, in 
this instance Motion Blur and alter again. You can do as many filters as 
you wish to the layer. You are then able to click on or off the filters to 
see the different effects by clicking on the little eye symbol. 

 
Colour Cast using the Histogram 

 
Open Histogram box and change the Histogram to colours. To correct 
the cast always add to it, never take away. 
Go to Image > Adjustment > Photo Filter. Choose the opposite to the 
cast and move the slider in the Density change whilst looking at the 
Histogram as you do it. i.e. reducing red by putting in cyan. 
Cyan – Red 



Blue – Yellow 
Magenta – Green 

 

Focus Stacking  

• Select the images taken with different focusing points 

• Open all the selected images in Raw and make the necessary 
adjustments then Select all and synchronise. 

• Either Save or Click done and Close Raw 

• Open Bridge and Select the adjusted images  

• Click on Tools in Bridge and go down to Photoshop and Load 
Files into Photoshop Layers 

• This will open all the images into how many layers as there are 
images selected 

• Select all the layers 

• Go to Edit, Auto Align Layers 

• Now go to Edit Auto Blend Layers 

• Make sure Stack Images and Seamless Tones and Colors are 
Checked 

• You can now click the layers on and off to see what has been 
done, layer masks have been created 

• Create a new empty layer about the layers 

• Right click on this layer and go down to Merge Visible and whilst 
holding the mouse on Merge Visible press the Alt Key at the 
same time, this will make a new layer with all the layers below 
blended together. 

• You can now work on this layer for blemishes, exposure etc. 
etc.Any dodging will not alter the original image. You can delete 
the layer if required or click off. This Overlay Layer is virtually a 
transparent layer but one that can be worked on 



 

 


